
Athena Visual Studio v14.1 to v14.2 
 
1. Fixed Bugs: Miscellaneous bugs reported by the user community. 
2. New Feature:   Parameter Param(205) in the @Solver Options section if set to a 

value greater than zero forces Athena to stop at a discontinuity point other than the 
very first one. For instance setting Param(205)=1 will force Athena to stop at the 
second discontinuity point if it exists. 

3. License Information: Updated Athena Visual Studio License information. To view 
the update from the Tools menu select Athena Visual Studio License Manager and 
then click View Athena Visual Studio License Terms. 



Athena Visual Studio v14.0 to v14.1 
 
4. Fixed Bugs: Miscellaneous bugs reported by the user community. 
5. User Functions: Added an option to use Fortran 90 syntax for user functions. In this 

way the user has the freedom to specify vector as well as complex functions. See 
Athena Visual Studio example in the …\Samples folder (mcComplex.avw).  

6. Keyword: Added new keywords for solver control via the @Solver Options section 
in the modeling code. To view all keywords, open an Athena Visual Studio project 
and from the View menu select Solver Parameters. 

7. New Functions:  Added new functions rand and randNormal to generate random 
numbers from uniform and normal distributions. See Athena Visual Studio help file 
for details of the implementation of these functions and examples in the …\Samples 
folder (mcRand.avw and mcMonteCarlo.avw).  

8. New Functions:  Added new mathematical functions FirstOrderDerivative and 
SecondOrderDerivative and FluxDerivative to calculate derivatives using Finite 
Difference formulas on uniform grids. See Athena Visual Studio help file for details 
of the implementation of these functions and examples in the …\Samples folder 
(mcFiniteDifferences.avw).  

9. New Functions:  Added new physical property functions EnthalpyForm and 
GibbsForm and StdLiqDensity to calculate the standard enthalpy of formation, the 
standard Gibbs free energy of formation and the standard liquid density of user 
selected components. See Athena Visual Studio help file for details of the 
implementation of these functions and examples in the …\Samples folder 
(mcPhysicalProperties.avw and mcPPHelp.avw).  

10. New Feature:   Parameter Param(204) in the @Solver Options section if set to one 
forces Athena to use the Run Sequence Plot as the default. If it is set equal to zero 
forces Athena to use the Parity plot as the default. 

11. New Feature:   A submenu in the Parameter Estimation Solver control panel 
allows the user to select all responses for estimation and also to clear the selected 
responses. The submenu is activated by a right mouse click on the list box that 
displays all the responses. 



Athena Visual Studio v12.3 to v14.0 
 
12. Block Data Structure: Beginning with v14.0 users will be able to define block data 

structures for parameter estimation form multiresponse data. See example 
PEM25.avw in the C:\Program Files\Athena\Samples\Parameter Estimation Models 
folder. 

13. New Functions: Added new functions Simpson and Gauss for the calculation of the 
definite integral of smooth functions. See Athena Visual Studio help file for details of 
the implementation of these functions and examples in the …\Samples folder 
(mcFunIntegral.avw and mcSimpson.avw) 

14. Fixed Bugs: Miscellaneous bugs that were persistent in the VisualKinetics Module. 
15. Updated Chemical Engineering Topics Help: Miscellaneous improvements to the 

Chemical Engineering subjects that are described in this help file. 
16. Plot Functions under Tools menu: This option has been extended to include user 

models that can be supplied via Dynamic Link Libraries that can be generated by 
Athena Visual Studio. The names of these DLLs must be Sub Fx(x,y,iFx) for two-
dimensional plots and Sub Fxz(x,z,y,iFxz) for three-dimensional plots. The integer 
arguments iFx and iFxz allow the user to enter more than one function in the same 
subroutine. Furthermore the following functions have also been implemented:  

 
min, max, range, sum, gamma, gami, gamic, psi, erf, erfi, erfc, erfci, beta, betai, 
ndist, ncdist, ninv, tdist, tcdist, tinv, fdist, fcdist, finv, chidist, chicdist, chiinv, 
wdist, wcdist, winv, lndist, lncdist, lninv, betadist, betacdist, betainv, gammadist, 
gammacdist, gammainv, besj, besy, besi, besk.  

 
All these functions are described in detail in the Athena Visual Studio Help file. The 
syntax for calling the user DLLs is y=Fxz(x,z,1)[;y1=Fxz(x,z,2)]. These DLLs must 
be placed in a folder that is in a  searchable by Windows path such as C:\Windows. 

17. Type Variables: Type variables can now be coded in Athena Visual Studio as 
follows: 

 
$$Type Input 
$$  Real*8:: Temperature 
$$  Real*8:: Pressure 
$$  Real*8:: Composition(100) 
$$  Real*8:: Kvalues(100) 
$$End Type Input 
 
Dim myInput As Type(Input) 
Input%Temperature=200.0 

 
A better way to implement Type variables is via a module. That gives the user more 
flexibility. An example of that can be found in the Athena Visual Studio samples 
folder \Athena\Samples\Fortran90\TestModule.avw 



18. New Subroutine: A new subroutine has been added in the AthenaUtilities module. 
The subroutine HessianMatrix( FCN, X, Hess [,Gradient] [,Eps] ) can be used to 
calculate the Hessian matrix and the Gradient vector of a scalar function that is 
supplied by the External FCN. An example of that can be found in the Athena Visual 
Studio samples folder \Athena\Samples\Stand Alone Models\mcHess.avw. This 
example is fully functional with the Compaq and Intel Visual Fortran Compilers. If 
you are using the g95 compiler you must delete the references to the Athena module 
and the call to mcHess subroutine and the Hessian function. 

19. Fixed Bug: The Help command button was disabled in the Fortran and Code 
Generation Options menu item under Build for the Compaq and Intel Compilers. 
This bug was been fixed in v14.0 

20. Update Help File: Updated the Fortran Programming Review section of the 
Fortran Compilers Help file. 

21. New Statement: Implemented the NameList Fortran specification statement. The 
NameList statement specifies a list of variables which can be referred to by one name 
selected by the user, for the purpose of performing input and/or output. An example 
of this specification statement can be found in the Athena Visual Studio samples 
folder \Athena\Samples\Ordinary Differential Equations\ODE20.avw. 

22. Fixed Bug: Sensitivity analysis with respect to initial values for differential and 
partial differential equations would not work if the number of equations was a 
variable and not a number. This bug has been fixed in v14.0. 

23. Fixed Bug: A bug was fixed in the Replace text window in the Athena Editor. The 
bug would show only if there were blank lines at the end of the user code and the 
Replace All command was issued followed by the Find Next command. 

24. New Feature: Added function doubleIntegral to calculate definite double integrals>. 
An example of this function can be found in the Athena Visual Studio samples folder 
\Athena\Samples\Stand Alone Model\mcDoubleIntegral.avw 

25. Update Help File: Updated the General Mathematics Module section of the Athena 
Visual Studio Help file. 

26. New Feature: Beginning with version v14.0 the user will be able to pass the Number 
of Equations, Number of Integration Points and Number of Continuation points as 
arguments into model subroutines for algebraic and differential models. This can be 
accomplished by issuing the following statement in the Solver Options section of the 
Athena code: variableNEQ=myNeq;myNpts;myNptcon. Here myNeq is the 
number of equations, myNpts the number of integration points and myNptcon the 
number of continuation points. 

27. New Feature: Beginning with version v14.0 the user will be able to pass the Number 
of Equations, Number of Grid Points, Number of Break Points, Number of 
Integration Points and Number of Continuation points as arguments into model 
subroutines for partial differential and boundary value models. This can be 
accomplished by issuing the following statement in the Solver Options section of the 
Athena code: variableNEQ=myNeq;myNgrid;myNbreak;myNpts;myNptcon. 
Here myNeq is the number of equations, myNgrid the number of grid points per 
element, myNbreak the number of breakpoints, myNpts the number of integration 
points and myNptcon the number of continuation points 



28. New Feature: Beginning with version v14.0 Athena will offer a number of functions 
to perform Flash calculations for Vapor/Liquid mixtures as well as Flash calculations 
of mixed streams with conventional components and solids. Please check the Physical 
Properties documentation for detailed information. 

29. New Feature: Beginning with v14.0 Athena will offer two functions pSteam and 
wSteam that will calculate steam and wet steam properties. To view a description of 
these functions check the Physical Properties book under Athena Visual Studio Help. 

30. New Feature: Beginning with version v14.0 Athena will offer a splines calculation 
block for easy interpolations. The block contains three functions: AkimaSplines, 
Cubic Splines and Quadratic Splines. Please read the General Mathematics Module 
help on Spline Interpolation. 

31. New Feature: Beginning with version v14.0 the Runge-Kutta methods for the 
integration of mildly stiff ODE’s have been enhanced to handle explicit 
discontinuities in the time domain. 

32. New Feature: Beginning with version v14.0 users will be able to identify solid 
components in the Physical Properties window. Set the Solid State to 0 for a 
conventional component or 1 for a solid component. 

33. New Feature: Beginning with v14.0 a new interface to the Athena functions and 
utilities has been implemented. The interface categorizes the functions into Fortran, 
Mathematical and Numerical, Statistical, Text and Utilities, Thermo and Unit 
Conversions so that it is very transparent to the user. The help files have also been 
updated to reflect the new architecture for the Athena Functions. 

34. New Feature: Object files linked to the user project no longer need to be placed in 
folders with empty spaces in the path name. An API that converts long path names to 
short path names has been implemented, so that the path names are compatible and 
the command option of the Compaq and Intel Visual Fortran Compilers. 

35. New Feature: Beginning with v14.0 users will be able to link the Athena Libraries 
with stand alone Fortran code. 

36. New Feature: Beginning with v14.0 users will be able to use the includeLocal 
keyword to includes parts of Fortran compatible code anywhere in their Athena 
project. Furthermore the $include keyword allows for the user to insert declaration 
statements that are coded in a separate file. The files accessed by the include and 
inludeLocal keywords must have filetype .for or .f 

37. New Feature: Beginning with v14.0 the user will be able to enter all the elements of 
the Param( 1 to 200 ) vectors that controls the Athena solvers through the @Solver 
Options section. To view a brief description of all Param(1 to 200) elements, open 
Athena Visual Studio , and from the View menu select Solver Parameters. 



38. New Feature: Beginning with version v14.0 users will be able to specify blocks of 
code as comments. The block of code is marked as follows: 

 
!*BEGIN: Start block of code that will be commented out by the Athena parser 
!--------------------------------------------------------------------------- 

Statement 1 
Statement 2 
: 

!*END: End block of code that will be commented out by the Athena parser 
!----------------------------------------------------------------------- 

 
!*BEGIN and !*END are required keywords. Anything else is optional. To request 
the Athena parser to process this block of code simple remove the * character from 
the !*BEGIN  keyword. 

 
 
 
 



Athena Visual Studio v12.2 to v12.3 
 
1. Updated Parameter Estimation Tutorial: Added description on the use of 

sensitivity analysis for the calculation of the gradient vector 
2. Updated Athena Visual Studio Help: Updated the section on Parameter Estimation 

with Implicit Models to synchronize with the Parameter Estimation Tutorial. 
3. Updated General Mathematics Module: Update the documentation of the General 

Mathematics Module and introduced a complete set of functions for the LQ 
Decomposition of a rectangular matrix A(m,n) . The old getQ function was replaced 
by the getQ1 because it was calculating the Q1 and NOT the Q matrix of the LQ 
decomposition. The complete set of functions for the LQ Decomposition of a 
rectangular matrix with full row rank, is given in the Athena On Line Help manual. 
To access it, open Athena Visual Studio and from the Help menu select Athena 
Visual Studio Help and then click General Mathematics Module. From there, you 
may select the topics Matrix Operations and Matrix Operations…Continued 

4. Fixed Bug: In the previous versions of Athena Visual Studio the semi-normalized 
sensitivity coefficients were computed incorrectly at the break points in the time-like 
dimension for mixed systems of differential and algebraic equations. The calculation 
was also incorrect for systems where the initial values of the first order sensitivity 
functions were non-zero. This bug has been fixed in version 12.3 

5. Updated Stand Alone Models Folder: Updated and cleaned up the folder that 
contains User Defined Models (Stand Alone Models). All examples now have a 
suitable self-descriptive name. 

6. Minor Improvements: In the Graph control panel textboxes the Fonts were changed 
to Arial and the 3D graphics in the solution of PDEs were improved. 

7. License Manager: License manager was updated to accommodate users with very 
restricted privileges in University Networks. This feature applies only to Academic 
License holders. 

8. Update Athena Visual Studio Help File: Updated the Miscellaneous Topics book in 
the Athena Visual Studio Help file to reflect the addition of new keywords for 
drawing true 3-dimensions graphs. The new keywords are Elevation, Rotation and 
Perspective. 

9. New Feature: Introduced a new feature; under the Tools menu the user can select 
Plot Functions in order to plot 2-dimensional (y=f(x)) and 3-dimensional functions 
(y=f(x,z)).  

 
 
 
 



Athena Visual Studio v12.1 to v12.2 
 
1. Add Function: Added the char Fortran Intrinsic in the reserved words list. 
2. Fix Bug: Fixed a bug occurring when the user selected a compiler in the Options 

window. The g95 compiler tab was not disabled or enabled based on the user’s 
selection. 

3. Fix Bug: Fixed a bug occurring when setting up Parameter Estimation or Nonlinear 
Optimization problems from Process Models that are active in Athena. The setup is 
now canceled when user changes his/her mind or chooses the same file name for 
estimation/optimization as the one for the Process Model. 

4. Fix Bug: Fixed a bug occurring when user double-clicks in an Error window 
(myAPP.ERR)  to locate an offending statement  when a floating point exception or 
FORTRAN compilation error occurs.  There is no check to ensure that the offending 
line number does not exceed the number of lines in the file that contains the offending 
statement. This error was not trapped and it caused Athena Visual Studio v12.1 to 
close. 

5. Add New Example: Added the Rat43 test case form the NIST Statistical Reference 
Datasets http://www.itl.nist.gov/div898/strd/ in the installation folder C:\Program 
Files\Athena\Samples\NIST Statistics. 

6. Fix Bug: Fixed a bug occurring when the user selects the  compilation option –fpe:0 
(under the Compaq and Intel Visual Fortran Compilers). Athena’s engine throws an 
exception due to overflow. This exception comes from the LAPACK function 
DLAMCH that computes machine parameters. This bug has been fixed via a keyword 
through the Solver Options. To avoid the floating point exception thrown by 
Athena’s engines when the –fpe:0 option is used, the users sets 
MachineParameters=1 in the Solvers Options section of the Athena code.  

7. Athena Interface: Minor updates to the Welcome: New Mode  Selection Panel 
Window 

8. Athena Interface: Updated the Athena Toolbar by adding a button to online Help. 
Fixed small errors in the shortcuts of various menu items. Some items were given the 
same shortcut letter. 

9. Fix Bug: Fixed a bug in the Partial Differential Equations training sample. The 
equation form based on the dimensionless state variables was incorrect. 

10. Fix Bug: Fixed a bug in the Visual Kinetics Control Panel. Second option for the 
selection of the reaction rate constants did not update the headers of the 
corresponding spreadsheet 

11. Fix Bug: Fixed a bug in the Optimal Experimental Design control panel. The data file 
with the proposed experimental design was very large because of the way it was 
saved. The file now is only a few KB large. 

12. Athena Tutorials: Added a Nonlinear Optimization Tutorial 
13. Athena Tutorials: Added a Boundary Value Problems Tutorial 
14. Athena Tutorials: Added a Partial Differential Equations Tutorial 
15. Athena Tutorials: Added a Visual Kinetics Tutorial 

http://www.itl.nist.gov/div898/strd/


16. Athena Sample Files: Updated description of Athena Samples in the Algebraic 
Models folder, Partial Differential Equations folder and Nonlinear Optimization 
folder 

17. Athena Interface: Enhanced Athena Toolbar with two shortcuts for debugging with 
Intel and Compaq compilers, and optimal experimental design 

18. Athena Training Samples: Added a Nonlinear Constrained Optimization sample. 
19. Update Help Files: Update the Athena Knowledge Base help file. 
20. Update Help Files: Update the Chemical Engineering Topics help file 
21. Update Help Files: Update the Athena Visual Studio Help file 
22. Update Help Files: Update the Fortran Compilers Help file 
23. Update Help Files: Update the Athena Solvers Help file 
 



Athena Visual Studio v11.0 to v12.1 
 
 
General Improvements 
  

1. Introducing the Athena Visual Studio Knowledge Base 
2. Ability for Version Control (Compaq and Intel Compilers only) 
3. Enhanced Chemical Engineering Help Material  
4. Enhanced Statistical Methods Help Material 
5. Enhanced Tutorials for Beginners 
6. On-Line Compiler Options 
7. Numerous Mathematical and Statistical Functions 
8. Detailed Documentation of Mathematical and Statistical Functions 
9. Added Graph Configuration File 
10. Added Component Insert Mode in Physical Properties 
11. Ability to create DLLs with Variable Number of Equations 
12. Ability to create Closed and Open Form Models with Variable Number of 

Equations 
13. Ability for User to Enter FORTRAN 95 Variable Declarations 

 
14. Seamless integration with the Compaq Visual Debugger with a Single Click 
15. Seamless Integration with the Intel Visual Debugger with a Single Click 

 
16. New License and Security Manager 
17. 15 Day FREE Evaluation Period (extended to 30 Day upon request) 
18. FREE Classroom Instruction License with Purchase of the Academic Research 

License 
19. Athena Visual Studio v12.1 runs under Windows VISTA 
20. User Account Control (UAC) Manager for Windows VISTA 
21. Improved, Searchable and well Organized Documentation 
22. Getting Started Help for Beginners 
23. New Expanded and Improved Monitor Statement 
24. Implementation of Shape-Preserving Quadratic Spline Interpolation 
25. Improved Interfaces and Bug Fixes from User Feedback 
26. Smart User Code for Solver Manipulation and Solver Options Command Section 
27. Enhanced Printing (Jacobian Matrices) and Troubleshooting 

  



Parameter Estimation and Model Discrimination  
  

1. Introducing Improved and Enhanced Optimal Experimental Design 
2. Continuous Monitoring of the Estimation Progress (for Large Problems) 
3. Simultaneous Integration of Blocks of Experimental Data for Fast Estimation 
4. Version 12.1 Allows for Missing Settings and Responses 
5. Version 12.1 Allows for Character Settings (ex. Catalyst Name or Type) 
6. Version 12.1 Allows the User to Select Responses for Fitting 
7. Grubbs' Test for Detecting Outliers 

  
Ordinary Differential and Algebraic Systems 
  

1. State and Sensitivity Vector Relative and Absolute Tolerances 
2. Implementation of Runge-Kutta 4th and 5th Order Integration Algorithms 
3. Implementation of Explicit Auxiliary Variables 
4. Introducing Ability to Store Integration History (Successful Steps) 

  
Partial Differential Systems 
  

1. Setup the Framework for Two-Dimensional Partial Differential Equations 
2. New Discretization Schemes for Hyperbolic PDEs 
3. Inhomogeneous domains with state and flux discontinuities 
4. State and Sensitivity Vector Relative and Absolute Tolerances 
5. Finite Differences on Finite Elements with User Imposed Continuity Conditions 
6. Implementation of Explicit Auxiliary Variables 
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